**Browser/End User Configuration Best Practices**

The following section outlines the minimum system requirements for an end user computer and browser configuration. These standards/settings should be followed to minimize end user issues when using the application.

**Computer Requirements**
The minimum hardware requirements are Pentium II 266mhz processor with 2 GB of RAM. The application is optimized for a 1440x900 screen but will work on larger/smaller screens. Javascript is required to be enabled in the browser.

**Supported Browsers**
eLogic Learning’s eSSential™ LMS is a web-based application that runs through a standard web browser. Internet Explorer 9 and higher, Google Chrome, Safaria and Firefox are the supported browser versions. Any browser that does not support JavaScript or has JavaScript disabled will not work with the LMS.

**Course Communications with LMS**
A small percentage of users will have issues either with the launch of an eLearning course or with the course being able to communicate progress to the LMS (bookmarking, status, score, detailed interactions, etc.). The eLearning (SCORM) engine utilizes JavaScript to handle communicates between the course and the LMS. The engine tests to determine if JavaScript communication is supported on the launch of the course. If it is not supported, the user will receive an error message and the course will automatically close. In some instances, the end-user’s browser communication circumvents the control and the user is allowed to proceed with the course launch even though the course cannot communicate successfully with the LMS. The following troubleshooting steps are suggested to determine why an end-user computer is not able to support the course to LMS communication.

- **Step 1** – Clear internet browser history (cache). Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 2.
- **Step 2** – Disable pop-up blockers for the site in the browser. Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 3.
- **Step 3** – If IE is the browser, add the URL for the LMS to the list of trusted sites in the client browser. Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 4. (see Internet Explorer Trusted Site Configuration for instructions)
- **Step 4** – Make sure JavaScript is enabled for the browser. Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 5. (see Enable JavaScripting for instructions).
- **Step 5** – If the course was developed in Articulate and the browser is IE, adjust the browser compatibility settings. Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 6. (see Articulate Course Issues with IE11 for instructions)
• Step 6 – Review list of plug-ins installed on browser to determine if any can be removed. Close all browsers, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 7. (see Browser Plug-Ins for instructions)

• Step 7 – Confirm the browser allows cookies to be used. Not all courses rely on cookies but some authoring tools utilize session cookies. After enabling cookies for the browser, close all browser windows, open a new browser window, login to the LMS and retry the course. If the issue is still present, proceed to Step 8.

• Step 8 – If your organization has the ability to modify the course and the course does not have a built in exit button, please add an exit button to the general navigation of the course. Allowing the course to exit using its standard functionality is a better practice than asking the user to close the course window. After republishing the course with an exit button, login to the LMS, load a new version of the course, create a new registration and retry the course. If the issue is still present, proceed to Step 9.

• Step 9 – If Step 1-8 did not solve the issue, please contact your LMS administrator to schedule a WebEx session with a support resource at eLogic Learning. The eLogic Learning support resource will use the Inspect Element (IE) or Developer Tools (Chrome) options to determine if the configuration/security issue can be found and resolved.

Delete Internet Browser History (Cache)

The links below will open vendor specific pages with instructions on how to delete browser cache (history).

• Internet Explorer
• Google Chrome
• Firefox

Internet Explorer Trusted Site Configuration

In order to ensure optimal performance when using IE, please add the site URL to the list of trusted sites in your browser. The screenshots below demonstrate how this is performed in IE9.

Step 1 – Open your browser and select Tools from the menu.

```
File  Edit  View  Favorites  Tools  Help
```

Step 2 – Select Internet Options from the Tools menu.

```
Internet options
```

Step 3 – From the Internet Options pop-up, select the Security tab. On the security tab, select the Green Checkmark image which will display the trusted sites section. Click on the trusted sites button.
Step 4 — Type the URL for the LMS in the Add this website to the zone box. Make sure you include the http:// or https:// (if you are an ecommerce client). Select the Add button and then Close. Select OK to close the Internet Options window.

Enable JavaScript
JavaScript is enabled by default in most browsers. The instructions below define how to confirm JavaScript has not been disabled.
**IE (Microsoft Internet Explorer)**

1) From the Gear in the upper-right corner of the screen or the “Tools” menu, select the “Internet Options” menu item.
2) Select the “Security” tab.
3) Select the zone you wish to modify. If the LMS URL has been added as a Trusted Site, this will be “Trusted site”. If the LMS is not a trusted site, this will most likely be “Internet.” On rare occasions (client installed LMS), this will be “Local intranet.”

4) Select the “Custom level…” button.
5) Scroll down to the scripting area and select “Enable”
1. Select the Chrome menu \(\uparrow\) in the top right hand corner of your browser
2. Select **Settings**
3. Click **Show advanced settings**
4. Under the "Privacy" section, click the **Content settings** button.
5. In the "Javascript" section, select "Allow all sites to run JavaScript (recommended)"

Content settings

**Cookies**

- Allow local data to be set (recommended)
- Keep local data only until you quit your browser
- Block sites from setting any data
- Block third-party cookies and site data

[Manage exceptions...][All cookies and site data...]

**Images**

- Show all images (recommended)
- Do not show any images

[Manage exceptions...]

**JavaScript**

- Allow all sites to run JavaScript (recommended)
- Do not allow any site to run JavaScript

[Manage exceptions...]

**Key generation**

- Allow all sites to use key generation in forms

[Done]
Articulate Course Issues with IE 11
There is a known issue with the exit button in courses built in Articulate Studio not working when launched with IE11. Not only will the exit button not cause the course to close, but you will also encounter issues where the course is not reporting status/score back to the LMS. To resolve the issue, compatibility mode has to be enabled for the browser. This effectively runs the IE11 browser as IE10. The following link is to an article on the Articulate Web Site regarding the issue.


Browser Plug-Ins
Depending on your eLearning courses and the material you place in the portal areas, your end-users will likely need other common internet plug-ins. Most of these plug-ins are standard and already installed on computers.

- Flash
- Adobe Viewer (PDF)
- Microsoft’s Media Player

Conversely, some plug-ins can cause issues with course communications with the LMS. Any browsers which can interfere with JavaScript communications should be removed. The instructions below will display the list of installed plug-ins for IE and Chrome.

**IE (Microsoft Internet Explorer)**

From the Tools menu, select the Manage Add-Ons menu option. The default Add-on Type is “Toolbars and Extensions.” This will display the list of plug-ins installed. Remove any item on the list that is not known or no longer needed.
### Manage Add-ons

View and manage your Internet Explorer add-ons

<table>
<thead>
<tr>
<th>Name</th>
<th>Publisher</th>
<th>Status</th>
<th>Architecture</th>
<th>Load time</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco WebEx LLC</td>
<td>Cisco WebEx LLC</td>
<td>Enabled</td>
<td>32-bit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Download Manager</td>
<td>Cisco WebEx LLC</td>
<td>Enabled</td>
<td>32-bit</td>
<td>(0.01 s)</td>
<td></td>
</tr>
<tr>
<td>WebEx Productivity Tools</td>
<td>Cisco WebEx LLC</td>
<td>Disabled</td>
<td>32-bit and...</td>
<td>(0.01 s)</td>
<td></td>
</tr>
<tr>
<td>McAfee, Inc.</td>
<td>McAfee, Inc.</td>
<td>Disabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>McAfee WebAdvisor BHO</td>
<td>McAfee, Inc.</td>
<td>Disabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Corporation</td>
<td>Microsoft Corporation</td>
<td>Enabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skype for Business Browser Helper</td>
<td>Microsoft Corporation</td>
<td>Disabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skype for Business Click to Call</td>
<td>Microsoft Corporation</td>
<td>Disabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Third Party Application Component</td>
<td>Microsoft Windows Third Party Application Component</td>
<td>Enabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shockwave Flash Object</td>
<td>Microsoft Windows Third Party Application Component</td>
<td>Enabled</td>
<td>32-bit and...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Select an add-on to modify status or view details.

Find more toolbars and extensions... 
Learn more about toolbars and extensions

Close
Chrome (Google)

Select the Customize and control Google Control toolbar button in the top right hand corner of the browser (three stacked dots). This opens the Chrome options menu. From this menu, select the More Tools option and the select the Extensions menu item.
Browse History Setting

If you are performing administrative functions in the LMS, you will want to ensure your browser is set to check for new versions of the web page each time the page is visited. To enable this setting in Internet Explorer, select Internet Options from the Tools menu in your browser. Once the internet options page opens, select the Settings Button under the Browsing History section of the General Tab. This will open the Temporary Internet Files and History Settings page. Make sure the “Every time I visit the webpage” option is selected.

Export to Excel

Excel introduced security settings in the Summer of 2016. If your users are experiencing issues opening spreadsheets from the LMS, it is the result of these settings. To resolve, there are two options. First, the user can simply download the file to their desktop and then open from the desktop. This is the safest method. The second option is to change their trust settings as follows. This will allow the Excel file to be opened directly.

In Excel, perform the following update to disable the Protected View.

- Select File menu
- Select Options
- Select Trust Center
- Select Trust Center Settings
• Select Protected View and uncheck each of the 3 options

This is a link to the Microsoft article explaining the change and their work to fix while maintaining a secure computing environment.


The Excel team has made a change in the behavior of certain file types to increase security. This change came in the security updates KB3115262, KB3170008, and KB3115322. The security update changed how Excel handles documents that are opened from untrusted locations (such the Internet zone) which are not supported in Protected View, such as HTML/XML/XLA files. Opening them without Protected View is a security vulnerability, and therefore files open from such locations are now blocked. We realize this breaks compatibility with some existing solutions, and are working on getting these file types supported with Protected View. Until that happens, users will need to manually trust the file before they open them in Excel, as demonstrated in one of the workaround suggestions. Excel can still open these files without an issue if they are trusted. We apologize that Excel is showing a blank screen instead of a more helpful error message with information about what to do next.

Our dev team is working on options to preserve security and assist customers with their workflow.
Skillsoft Course Users
Skillsoft is the world’s largest supplier of eLearning courses. When courses are purchased from Skillsoft and loaded into an LMS, the Skillsoft course is launched from the LMS but plays in a java applet based on files hosted on a Skillsoft web server. This configuration can lead to triggering security settings on certain browser configurations. The following steps should resolve any issues encountered when playing a skillsoft course. Update – Starting in October 2014, Skillsoft started migrating their courses away from java players to HTML5 players. As a result of their library having thousands of courses, this migration process will take some time but they are prioritizing the most used courses first. If a user’s browser supports HTML5 (IE10+, Chrome, Firefox and Safari), the course will automatically open in the HTML5 player. If the browser does not support HTML5, then the course will continue to play in the java player and the steps below should help address course performance issues in that situation. Additionally, we have included links to Skillsoft’s Knowledgebase for java and the HTML5 player. This will contain the latest Skillsoft recommended configuration settings. As browsers and internet technologies change, this is the best source for updated information on Skillsoft course issues.


Step 1 – Add *.skillwsa.com and *.skillport.com to the list of Trusted Sites in your browser. For instructions on how to add a trusted site, please refer to the Internet Explorer Browser Configuration section of this user guide. After add the trusted sites, close all browsers, re-open your browser and then try to play the course. If this did not resolve your issue, please proceed to Step 4.

Step 2 – In some instances, users have experienced issues with Anti-Virus security blocking the course or causing delays in the course. Depending on the anti-virus you are using, the method to trust the Skillsoft web site or allow the java calls to work will vary. Please consult with your IT team. Temporarily disabling your antivirus and then testing the course will allow you to determine if your antivirus is causing the issue. If this did not resolve your issue, please contact your LMS administrator to open a ticket with eLogic Learning for further assistance.

Courses with Very Large Videos
If a course is built using a large number of Flash components or is built with large video files, it is a recommended best practice to utilize ‘Preloaders’ in the design of the course. The ‘Preloaders’ help prepare the browser for upcoming videos. This tells the course to begin loading the video before the users gets to the page with the video on it. This minimizes user wait time for the video to load.

Chrome Flash Issues
The link below opens a Google Support website which outlines troubleshooting steps for users who are having course issues in Chrome but not in IE or other browsers. If the course uses Flash technology, these steps will likely resolve the issue.

https://support.google.com/chrome/answer/6258784?hl=en